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Safety Information 

 
 

 

The CY6611 EZ-USB® HX3PD Evaluation Kit (EVK) is intended for use as a development platform for hardware or software in a 
laboratory environment. The board is an open-system design, which does not include a shielded enclosure. Due to this reason, 
the board may cause interference to other electrical or electronic devices in close proximity. In a domestic environment, this product 
may cause radio interference. In such cases, take adequate preventive measures. Also, do not use this board near any medical 
equipment or RF devices.  

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its performance 
and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable mitigating measures 
must be taken. 

 

 

The CY6611 EZ-USB HX3PD EVK contains ESD-sensitive devices. Electrostatic charges readily 
accumulate on the human body and any equipment, and can discharge without detection. Permanent 
damage may occur on devices subjected to high-energy discharges. Proper ESD precautions are 
recommended to avoid performance degradation or loss of functionality. Store unused CY6611 EZ-USB 
HX3PD EVK boards in the protective shipping package. 

 

 

 

End-of-Life/Product Recycling 

This kit has an end-of-life cycle of five years from the year of manufacturing mentioned on the back of the 
box. Contact your nearest recycler for discarding the kit. 

General Safety Instructions 

ESD Protection 
ESD can damage boards and associated components. Cypress recommends that you perform procedures only at an ESD 
workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap attached 
to the chassis ground (any unpainted metal surface) on the board when handling parts.  

Handling Boards  
CY6611 EZ-USB HX3PD EVK boards are sensitive to ESD. Hold the board only by its edges. After removing the board from its 
box, place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any surface. 

Any physical action on the CY6611 EZ-USB HX3PD EVK such as changing wires, jumper settings, or measuring voltages can 
cause stress on the CY6611 printed circuit board assembly (PCBA) and Type-C connectors. Ensure that the PCBA has proper 
support on the bottom side to avoid stress on the PCBA when the EVK is in operation. 
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Do’s and Don’ts 

 

 

 

 Do not supply power through DC Power Jack (D12) and DC Terminal (J11) simultaneously. 
This may damage the CY6611 EVK board. 

 If an external DC power source is used to power the CY6611 EVK board, ensure that the power 
supply is connected to the DC Terminal (J11) as per the marked polarity (+/-). 

 Do not exceed 20 V DC input at the DC Terminal (J11) of the CY6611 EVK board. 

 Do not make any hardware modifications to the CY6611 EVK board. Such modifications may 
make the CY6611 EVK unusable. 

 Do not apply voltage on the test points more than what they are rated for. 

 Do not apply reverse voltage on the power domain test points. 

Identifying Kit Revision and Serial Number 

The CY6611 kit revision and serial number are printed on a sticker and pasted at the bottom side of the CY6611 kit box. See the 
figure below for more details.  
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1 Introduction 

 
 

 

The CY6611 EZ-USB® HX3PD EVK is based on the Cypress’ EZ-USB HX3PD Hub controller (CYUSB4347-BZXC). HX3PD is a 
family of USB 3.1 Gen 2 (10 Gbps) Type-C Hub controllers with USB Power Delivery (PD) that complies with the USB 3.1 Gen 2 
specification, and the latest Type-C and PD standards. CYUSB4347-BZXC is a USB-IF certified USB 3.1 Gen 2 (10 Gbps) hub 
silicon (TID # 5030000008). The CY6611 EVK is a 7-port evaluation kit designed to demonstrate the USB 3.1 Gen 2 hub, PD 3.0 
and Battery Charging (BC 1.2) functionalities of the HX3PD controller. 

1.1  Kit Contents 

The following are the contents of the CY6611 EZ-USB HX3PD EVK: 

 CY6611 EZ-USB HX3PD EVK Board (One number) 

 19-V, 65.2-W AC/DC Power Adapter (One number) 

 USB Full-Featured Type-C Cable (One number) 

 Quick Start Guide 

Figure 1-1. CY6611 Kit Contents 

  

1.2  List of Recommended Hardware  

See Table 1-1 for the list of recommended hardware for CY6611 EVK to demonstrate the various kit operations described in the 
Kit Operation chapter. The recommended hardware can be replaced by equivalent hardware based on availability. 

Table 1-1. List of Recommended Hardware 

No. Description Manufacturer MPN 

1 Laptop with USB 3.1 Gen 2 (10 Gbps) and USB PD support Lenovo T470 

2 USB 3.1 Gen 2 (10 Gbps) Solid State Drive (SSD) or Hard Disk Drive (HDD) Samsung T5 

3 Smart phone with USB PD support Xiaomi Mi 6 

4 USB 3.1 Gen 1 (5 Gbps) SSD/ HDD/ Flash Drive SanDisk - 

5 USB 2.0 Flash Drive Generic - 

6 Smart phone with BC 1.2 specification support - - 

7 Apple device with support for Apple Charging Apple - 

8 Digital Multimeter Generic - 

9 USB Type-C to Type-A cable (Optional. Required for programming HX3PD 
firmware from a PC/Laptop that does not have a Type-C port) 

JAE Electronics DX07519S10L19294 
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1.3 Getting Started 

The user guide helps to familiarize you with the CY6611 HX3PD Evaluation Kit. The Installation chapter provides step-by-step 
instructions to install the software required for the kit. The CY6611 System Design chapter describes the hardware design and 
functional description of the kit. The features and the procedure to demonstrate the features of the kit are explained in the Kit 
Operation chapter. The Programming the HX3PD Controller chapter describes the general overview of the EZ-USB HX3PD 
Configuration Utility and the procedure for configuring and programming the HX3PD controller using the software utility. 

1.4  Additional Learning Resources 

Cypress provides a wealth of information at www.cypress.com to help you to select the right device for your design, and help you 
to understand the functionalities and capabilities of the HX3PD controller. The online resources provided in Cypress’ official 
website also help you to quickly and effectively integrate the device into your design. The following is the list of online references 
for HX3PD and CY6611 EVK: 

 Overview: Cypress USB Controller Roadmap 

 Product Webpage: EZ-USB® HX3PD: USB 3.1 Gen 2 Hub with Power Delivery 

 Datasheet: HX3PD: USB 3.1 Gen 2 Hub with Power Delivery  

 Application Note: AN222944 - HX3PD Hardware Design Guidelines and Checklist 

 Kit Webpage: CY6611 EZ-USB HX3PD EVK 

1.4.1 Technical Support 
If you have any questions, our technical support team is happy to assist you. You can create a support request on the Cypress 
Technical Support page. 

You can also use the following support resources if you need quick assistance: 

 Self-help 

 Local Sales Office Locations 

1.5  Document Conventions 

Table 1-2. Document Conventions for Guides 

Convention Usage 

Italics Displays file locations, file names, and reference documentation: 
Read about the sourcefile.hex file in the PSoC Creator User Guide. 

[Bracketed, Bold] Displays keyboard commands in procedures: 
[Enter] or [Ctrl] [C] 

File > Open Represents menu paths: 
File > Open > New Project 

Bold Displays commands, menu paths, and icon names in procedures: 
Click the File icon and then click Open. 

 

https://www.cypress.com/
https://www.cypress.com/file/206291/download
https://www.cypress.com/products/ez-usb-hx3pd-usb-31-gen-2-hub-power-delivery
https://www.cypress.com/documentation/datasheets/cyusb4347cyusb4357-hx3pd-usb-31-gen-2-type-c-hub-pd
https://www.cypress.com/documentation/application-notes/an222944-hx3pd-hardware-design-guidelines-and-checklist
https://www.cypress.com/CY6611
https://www.cypress.com/support
https://www.cypress.com/support
https://www.cypress.com/support
https://www.cypress.com/about-us/sales-offices
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1.6 Abbreviations 

Acronym/Abbreviation Expanded Form 

BC Battery Charging 

CDP Charging Downstream Port 

DCP Dedicated Charging Port 

DFP Downstream Facing Port 

DMC Dock Management Controller 

DRP Dual-Role Port 

DS Downstream 

EC Embedded Controller 

ESD Electrostatic Discharge 

EVK Evaluation Kit 

FS Full Speed 

GPIO General-Purpose Input/Output 

GUI Graphic User Interface 

HS High Speed 

I2C Inter-Integrated Circuit  

I/O Input/Output 

LED Light Emitting Diode 

LS Low Speed 

PC Personal Computer 

PD Power Delivery 

PDO Power Data Object 

PID Product ID 

SCL Serial Clock 

SDA Serial Data 

SDP Standard Downstream Port 

SPI Serial Peripheral Interface 

SS SuperSpeed 

UFP Upstream Facing Port 

US Upstream 

USB Universal Serial Bus 

VID Vendor ID 
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2 Installation 

 
 

 

This chapter describes the installation procedure for the CY6611 EZ-USB HX3PD EVK. The installation includes software, 
documentation, firmware, and hardware design files.  

Following are the software utilities which are needed to operate the CY6611 EVK.  

1. EZ-USB HX3PD Configuration Utility: This utility is required to configure the HX3PD firmware (DMC and PD Controller 
firmware) and to download the firmware to the CY6611 EVK. 

2. EZ-PD Configuration Utility: This utility is launched by the EZ-USB HX3PD Configuration Utility to configure the DMC and 
PD Controller firmware. 

The CY6611 EVK installation is a three-step process which is described in the following sections. Make sure that the installation 
is done only in the same order as specified. 

 

2.1 Installing the EZ-PD Configuration Utility 

1. Download the latest EZ-PD Configuration Utility setup file from the utility webpage. The setup file contains the executable 
files for the utility and the documentation (User Manual and Release Notes). Double-click the executable to start the 
installation. Click Next when the screen shown in Figure 2-1 appears and go through rest of the installation process. 

Figure 2-1. EZ-PD Configuration Utility Installer Screen 

 

  

https://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
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2.2 Installing the EZ-USB HX3PD Configuration Utility 

1. Download the latest EZ-USB HX3PD Configuration Utility setup file from the utility webpage. The setup file contains the 
executable files for the utility and the documentation (User Manual and Release Notes). Double-click the executable to start 
the installation. Click Next when the screen shown in Figure 2-2 appears and go through rest of the installation process. 

Figure 2-2. EZ-USB HX3PD Configuration Utility Installer Screen 

 

 

2.3 CY6611 EZ-USB HX3PD EVK Software Installation 

1. Download the latest kit setup file from the kit’s webpage. This package contains the kit hardware design files, 
firmware, and the kit documentation (Kit Guide, Quick Start Guide, and Release Notes). Double-click the 
executable to start the installation. Click Next when the screen shown in Figure 2-3 appears and proceed with 
the installation process. 

Figure 2-3. CY6611 EZ-USB HX3PD EVK Installer Screen 

 

 

https://www.cypress.com/documentation/software-and-drivers/ez-usb-hx3pd-configuration-utility
http://www.cypress.com/CY6611
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2.4 Cypress Update Manager Check 

1. When the installation is complete, you have the option to launch the Cypress Update Manager (Figure 2-4) to make 
sure you have the latest packages. Click Check for updates. If No Updates appears adjacent to the CY6611 EZ-USB 
HX3PD EVK, EZ-USB HX3PD Configuration Utility and EZ-PD Configuration Utility entries, click Exit. If there are 
updates, click Update to download and install the corresponding package. 

Figure 2-4. Sample Cypress Update Manager Screenshot 

 

 

Note 1: The Cypress Update Manager screenshot shown in Figure 2-4 does not show the CY6611 EVK. Scroll through the 
list to locate CY6611 EVK. 

Note 2: You can launch the Cypress Update Manager at any time from Start > All Programs > Cypress > Cypress Update 
Manager. 

Note 3: After the installation is complete, the contents are available at this location: <Install Directory>\CY6611 EZ-USB 
HX3PD EVK\1.0\. On the Windows 32-bit platform, the default <Install Directory> is C:\Program Files\Cypress; on the 
Windows 64-bit platform, it is C:\Program Files (x86)\Cypress. 
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3 CY6611 System Design 

 
 

 

This chapter describes the features supported by the CY6611 EVK and the hardware design details of the EVK. 

3.1 CY6611 EVK Overview 

CY6611 EVK enables evaluation of the following features of the EZ-USB HX3PD controller: 

 USB Gen 2 (10 Gbps) data transfer on five Downstream (DS) ports (DS1-DS5).  

 USB 2.0 data transfer on seven DS ports (DS1-DS7) 

 USB PD 3.0 charging on Upstream (US) and DS1 port 

 USB Battery Charging (BC v1.2) and Apple charging on four DS ports (DS2-DS5) 

 Configure and program the HX3PD firmware 

Table 3-1 lists the port wise capabilities and the connector types used on the CY6611 EVK hardware. 

Table 3-1. CY6611 Port Capabilities 

 

 

  
 

1 The maximum power consumed by all the ports should not exceed 55 W which is limited by the capacity of the power adapter provided with the kit. However, the 
HX3PD firmware can be configured to support USB PD charging at 20 V, 3 A on both the US and DS1 ports simultaneously. See the Programming the HX3PD 
Controller chapter to configure the HX3PD firmware for this requirement. 

Port Connector 

Type 

USB Speed Charging Protocols Default Charging 

Configuration1  

Upstream (US) 

US Type-C USB 3.1 Gen 2 (10 Gbps) USB PD 3.0 2.3 A at 20 V (46 W) 

Downstream (DS) 

DS1 Type-C USB 3.1 Gen 2 (10 Gbps) USB PD 3.0 1 A at 5 V (5 W) 

DS2 Type-C USB 3.1 Gen 2 (10 Gbps) BC 1.2, Apple Charging 2.4 A at 5 V (12 W) 

DS3 Type-C USB 3.1 Gen 2 (10 Gbps) BC 1.2, Apple Charging 2.4 A at 5 V (12 W) 

DS4 Type-A USB 3.1 Gen 2 (10 Gbps) BC 1.2, Apple Charging 2.4 A at 5 V (12 W) 

DS5 Type-A USB 3.1 Gen 2 (10 Gbps) BC 1.2, Apple Charging 2.4 A at 5 V (12 W) 

DS6 Type-A USB 2.0 (480 Mbps) SDP Charging 500 mA at 5 V (2.5 W) 

DS7 Type-A USB 2.0 (480 Mbps) SDP Charging 500 mA at 5 V (2.5 W) 
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3.2 CY6611 Hardware Design 

This section provides details of the CY6611 hardware architecture, power supply design, and the hardware interfaces. 

3.2.1 CY6611 Hardware Design Overview 
Figure 3-1 illustrates the CY6611 hardware design. CY6611 hardware is designed to evaluate the USB Gen 2 and USB PD 
capabilities of HX3PD controller on all applicable ports.  

Figure 3-1. CY6611 EVK Hardware Block Diagram 

 

The board is powered through one of the following two DC input interfaces: DC Power Jack (J12), DC Terminal (J11). The DC 
input is fed to the following four DC-DC regulators to power various parts of the system: 

1. DC-DC Regulator (DC-DC REG1) provides a 5-V output which is fed to two additional DC/DC regulators (3.3 V and 1.2 V) 
whose outputs power HX3PD. 

2. DC-DC Regulator (DC-DC REG2) provides a 5-V output which powers VBUS on DS2 to DS7 ports. The 5-V output from this 
regulator powers the switch associated with each of the DS ports (DS2-DS7). These power switches are controlled by 
HX3PD’s Hub Controller to enable VBUS on the DS ports (DS2-DS7). 

3. DC-DC Regulator (US PD REG) provides VBUS on the US port based on the USB PD contract negotiated between HX3PD 
and the PD capable laptop connected on the US port. Output from this regulator can be configured to support the complete 
USB PD voltage range (5 V to 20 V). The PD controller of HX3PD configures this regulator over I2C interface based on the 
PD contract negotiated with the laptop connected on the US port. 

4. DC-DC Regulator (DS1 PD REG) provides VBUS on the DS1 port based on the USB PD contract negotiated between HX3PD 
and the PD capable device connected on the DS1 port. Output from this regulator can be configured to support the complete 
USB PD voltage range (5 V to 20 V). The PD controller of HX3PD configures this regulator over I2C interface based on the 
PD contract negotiated with the device connected on the DS1 port. 
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The hardware design files of CY6611 EVK (Schematics, BoM, and layout files) are available as part of the kit installation at 
<Install_Directory>\CY6611 EZ-USB HX3PD EVK\1.0\Hardware. 

Note: On Windows 32-bit platforms, the default <Install Directory> is C:\Program Files\Cypress, and on Windows 64-bit 
platforms, it is C:\Program Files (x86)\Cypress. 

3.2.2 CY6611 Jumpers, LEDs and Headers 
This section provides details of various interfaces of the CY6611 EVK board. 

Figure 3-2. CY6611 EVK Board Interfaces 

 

Table 3-2 provides details of the three jumpers available on the CY6611 EVK hardware. 

Table 3-2. CY6611 EVK Jumpers 

# Jumper Header Description Default State 

1 J2 DMC LED Jumper. Jumper to enable DMC LED Jumper is installed 

2 J6 
1.2-V Supply Jumper. Jumper to enable 1.2-V supply to the 
HX3PD controller. 

Jumper is installed 

3 J10 
3.3-V Supply Jumper. Jumper to enable 3.3-V supply to the 
HX3PD controller 

Jumper is installed 
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Table 3-3 provides details about the five LEDs available on the CY6611 EVK hardware. 

Table 3-3. CY6611 EVK LEDs 

# LED Identifier Description States 

1 
LED1  

(DMC LED) 
LED to indicate the state of the DMC 

Blinks when HX3PD FW is active. Switches between 
normal and rapid blinks during firmware 
programming.  

2 
LED2  

(PD CTRLR LED) 

LED to indicate the state of the PD 
controller 

Blinks when HX3PD FW is active 

3 LED3 LED for the 5.0-V power domain (VCC) ON when the EVK is powered 

4 LED4 LED for the 3.3-V power domain (3V3) ON when the EVK is powered 

5 LED5 LED for the 1.2-V power domain (V1P2) ON when the EVK is powered 

 

Figure 3-3. CY6611 EVK Headers 

 

 

 

CY6611 EVK board has two 26-pin headers (J3 and J4) which provide access to the key pins of the HX3PD controller. The signals 
terminated on these headers are marked as part of CY6611 EVK board’s top side silkscreen as shown in Figure 3-3. 

Table 3-4 provides more details about the signals terminated on the J3 header. Note that the pin numbers are arranged matching 
with the header layout on the CY6611 EVK board. 

 

 

Pin # 1 of J4 header 

Pin # 1 of J3 header 

J4 header pin details 

J3 header pin details 
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Table 3-4. J3 Header Details 

 

Table 3-5 provides more details about the signals terminated on the J4 header. Note that the pin numbers are arranged matching 
with the header layout on the CY6611 EVK board. 

Table 3-5. J4 Header Details 

 

Pin # Signal Name Description Pin # Signal Name Description 

26 

EGND Ground 

25 

EGND Ground 24 23 

22 21 

20 CC2_DS1 CC2 of DS1 port 19 CC2_DS3 CC2 of DS3 port 

18 CC1_DS1 CC1 of DS1 port 17 CC1_DS3 CC1 of DS3 port 

16 CC2_US CC2 of US port 15 CC2_DS2 CC2 of DS2 port 

14 CC1_US CC1 of US port 13 CC1_DS2 CC1 of DS2 port 

12 OCP_DET_P0 OCP Detection for US 11 OVCUR1 Overcurrent detect for DS1 

10 EGND Ground 9 VSEL2_GPIO4 Reserved 

8 DS_NCP_ENB DS1 PD regulator enable 7 VSEL2_GPIO3 Reserved 

6 VBUS_DISCHARGE_US US VBUS Discharge control 5 VBUS_DISCHARGE_DS DS1 VBUS Discharge control 

4 US_NCP_ENB 
US VBUS Consumer path 
control 

3 VBUS_C_CTRL_DS 
DS1 VBUS Consumer path 
control 

2 VBUS_P_CTRL_US 
US VBUS Provider path 
control 

1 VBUS_P_CTRL_DS 
DS1 VBUS Provider path 
control 

Pin # Signal Name Description Pin # Signal Name Description 

26 

EGND Ground 

25 

EGND Ground 
24 23 

22 21 

20 19 

18 VBUS_US Upstream VBUS 17 
NC No Connection 

16 
NC No Connection 

15 

14 13 I2C_SCL_SPARE 

External I2C interface 12 
DMC_P32 

GPIO for resetting for Hub 
Controller 

11 
I2C_SDA_SPARE 

10 
DMC_P26 

GPIO for controlling DMC FW 
LED 

9 
I2C_MSTR_SCL 

I2C to configure the DC-DC 
regulators which provide 
power on the PD ports (US 
and DS1) 8 DMC_P25 Reserved 7 I2C_MSTR_SDA 

6 
DMC_P24 

GPIO for EEPROM Write 
Protect enable 

5 
PD_HUB_INT Reserved 

4 VCONN_MON_P1 GPIO of PD Controller 3 I2C_SCL_EC I2C SCL for EC 

2 VCONN_MON_P0 GPIO of PD Controller 1 I2C_SDA_EC I2C SDA for EC 
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3.2.3 Measuring Power Consumed by HX3PD Controller  
HX3PD is powered by 1.2 V and 3.3 V power domains. The total power consumed by HX3PD can be measured using the following 
procedure any time during the operation of the kit. Note that this procedure requires two digital multimeters to measure current 
consumed on 1.2 V and 3.3 V domains simultaneously. 

1. Detach the power supply from the CY6611 EVK board. 

2. Remove the jumpers installed at jumper headers J6 (1.2-V supply) and J10 (3.3-V supply). 

3. Set both the digital multimeters in Ampere mode and attach them to headers J6 and J10. 

4. Supply power to the CY6611 EVK board and operate the features of the kit as required. See the Kit Operation chapter for 
more details. 

5. Measure the current consumed on both 1.2 V (J6) and 3.3 V (J10) domains 

6. The total power consumed by HX3PD can be calculated as: 

HX3PD Power Consumption (mW) = 1.2 x (measured current in 1.2V domain) + 3.3 x (measured 

current in 3.3 V domain) 
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4 Kit Operation 

 
 

 

This chapter describes the procedure to demonstrate the USB 3.1 Gen 2 Hub (10 Gbps), PD 3.0 and Battery Charging (BC 1.2) 
features supported by the CY6611 EVK. See Kit Contents for the contents of the kit and List of Recommended Hardware for 
additional hardware required to demonstrate these features. 

It is recommended that you read this guide in the order that the sections are presented.  

4.1 Pre-requisites  

The following items are needed to perform the kit operations: 

 Items provided with the kit: 

 19-V, 65.2-W AC/DC power adapter 

 CY6611 EVK board 

 USB Full-Featured Type-C Cable 

 Items not provided with the kit: 

 Laptop with USB 3.1 Gen 2 (10 Gbps) and USB PD support 

 USB 3.1 Gen 2 (10 Gbps) Solid State Drives (SSD) 

 USB 2.0 flash drives 

 Multimeter 

4.2  Powering CY6611 EVK 

Follow these steps to power the CY6611 EVK: 

1. Unpack the kit package and check the kit contents. 

2. Verify that jumpers are installed at J2, J6, and J10 as shown in Figure 4-1. 

3. Connect the power adapter provided with the kit to the DC Power Jack (J12) of the CY6611 EVK board. Plug the other end 
of the power adapter into an AC power socket. 

4. Power LEDs (LED3 - LED5) glow green to indicate that the kit is powered. Also, the PD CTRLR LED and DMC LED blink 
green to indicate that the firmware is running and the kit is ready for operation. 
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Figure 4-1. CY6611 EVK Hardware Interfaces 

 

Note: The maximum power consumed by all ports should not exceed 55 W when used with the power adapter provided with 
the kit. If the total power requirement for the devices to be connected to the ports of CY6611 EVK exceeds 55 W, use a higher 
capacity power source to power the kit. The new power source can be a higher capacity power adapter or bench power 
supply. The power adapter needs to be connected to the kit through the DC Power Jack (J12) and the bench power supply 
need to be connected on the DC Terminal (J11). 

Following is the criteria for the Power Adapter if new Power Adapter with higher capacity is required:  

 Maximum output voltage of 20 V 

 DC Barrel specification: 

 Polarity: Center Positive 

 Outer diameter: 5.5 mm 

 Inner diameter: 2.1 mm 

 Safety approvals such as UL 

Note: Check and ensure that the power adapter has the necessary safety approvals required for the country where it is 
used 

Important Notes 

 Do not supply power to the CY6611 kit hardware at both the power interfaces (J12 and J11). Doing so may damage the 
kit hardware. 

 Make sure that bench power supply is connected to the kit hardware (J11) as per the marked polarity. Also, ensure that 
the maximum output from the bench power supply does not exceed 20 V. 

 Make sure that the DC plug of the power adapter is of ‘Center Positive’ type. Using a power adapter with incorrect polarity 
may permanently damage the kit hardware.  
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4.2.1 Troubleshooting 

Table 4-1. Procedure to Troubleshoot Issues with Powering of CY6611 EVK 

# Issue Possible Cause Troubleshooting Procedure 

1 
Power LEDs (LED3-LED5) 
are not glowing 

Incompatible power adapter 

If an AC-DC power adapter which is not provided with the kit is 
being used, it may not be a compatible adapter. See the Powering 
CY6611 EVK section to understand the selection criteria for the 
power adapter. 

Jumpers are not populated Ensure that jumpers are installed on J6, and J10 headers. 

2 
PD CTRLR, DMC, or both 
LEDS are not glowing 

HX3PD kit hardware may not 
have been loaded with 
correct firmware 

Download the correct HX3PD firmware on the kit hardware. See the 
Programming the HX3PD Controller chapter for more details.  

Jumper is not populated Ensure the jumper is installed on J2 header 

4.3  Connecting EVK to Laptop 

1. Connect the Type-C cable provided with the kit to the CY6611 EVK board’s US port. Connect the other end of the Type-C 
cable to the Type-C port on a laptop supporting USB 3.1 Gen 2 (10 Gbps) and USB PD.  

Figure 4-2. Connecting the CY6611 EVK to Laptop 

 

2. Open Control Panel on laptop. From the Control Panel window, click Device Manager. See Figure 4-3. Note that the 
screenshots are captured on a laptop running Windows 10. If you are running on a different OS, screenshots may differ.  
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Figure 4-3. Invoking Device Manager on a Windows 10 Laptop 

 

 

3. Expand Universal Serial Bus controllers to see the list of USB devices attached to the laptop. The evaluation kit is listed 
as Generic SuperSpeed USB Hub and Generic USB Hub.  

Figure 4-4. Enumeration of HX3PD on the Laptop 

 



  Kit Operation 

CY6611 EZ-USB HX3PD Evaluation Kit Guide, Document Number: 002-26068 Rev *A 23 

4. Right-click Generic SuperSpeed USB Hub and open Properties. Go to the Details tab and choose Hardware Ids from the 
Property drop-down list. The Cypress VID and PID are displayed as shown in Figure 4-5.  

Figure 4-5. CY6611 VID and PID 

 

4.4 Demonstrating USB 3.1 Gen 2 (10 Gbps) Data Transfer 

This section demonstrates the USB 3.1 Gen 2 (10 Gbps) data transfer capability of the HX3PD controller using the CY6611 
EVK. This section also demonstrates the procedure for USB 2.0 transfer. 

See CY6611 Hardware Design Overview to understand the capabilities supported by the DS ports and US port of the HX3PD 
controller. 

1. Get a USB 3.1 Gen 2 (10 Gbps) certified Solid State Drive (SSD) and store a 5 GB file. 

2. Connect the drive to any of the five USB Gen 2 DS ports (DS1 to DS5) as shown in Figure 4-6 using the USB cable provided 
with the SSD. 

Figure 4-6. USB 3.1 Gen 2 Data Transfer Setup 

 
 
Note: CY6611 EVK’s DS1-DS3 ports are Type-C USB connectors and DS4-DS5 ports are Type-A USB connectors. Pick the 
DS port (DS1-DS5) for connecting the SSD based on the connector type supported by the USB cable provided with the SSD. 
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3. Copy the 5 GB file from the drive to the laptop to transfer data in the USB 3.1 Gen 2 (10 Gbps) mode. Note that the actual 
data transfer rate observed on the laptop may vary based on the hardware/software configuration of the laptop and the SSD 
used. 

4. Connect more drives (USB 3.1 Gen 2, USB 3.1 Gen 1, or USB 2.0) to other DS ports to check multiple types of data transfers 
simultaneously. See Figure 4-7 for a sample set up. 

Figure 4-7. USB 3.1 Gen 2, USB 3.1 Gen 1 and USB 2.0 Devices Connected to DS Ports 

 

4.4.1 Troubleshooting  

Table 4-2. Procedure to Troubleshoot Issues with Data Transfer Operation 

# Issue Possible Cause Troubleshooting Procedure 

1 
Data transfer is not happening at USB 
3.1 Gen 2 (10 Gbps) speed 

The USB 3.1 Gen 2 SSD may not have been 
connected to a USB 3.1 Gen 2 port. 

Ensure that the SSD is connected to one 
of the DS ports (DS1 to DS5) which 
support USB 3.1 Gen 2 data transfer. 

The SSD may be non-compliant with USB 
3.1 Gen 2 standard 

Ensure that a USB 3.1 Gen 2 certified 
SSD is used. 

Multiple simultaneous data transfers may be 
happening which will result in sharing of the 
USB bus bandwidth. 

Stop all data transfers on the USB bus 
except the one to be used for 
demonstrating USB 3.1 Gen 2 data 
transfer speed. 

2 

Detaching a mass storage device (USB 
3.1 Gen 2/ Gen 1 / USB 2.0) from a DS 
port while data transfer is in progress 
causes data transfers happening on 
other DS ports to stop 

The Operating System running on the host 
PC may have issues with handling device 
detach events on USB 

Check for the latest OS updates and 
install those updates on the host PC and 
check 
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4.5 Demonstrating USB PD Charging on US and DS1 Ports 

This section demonstrates the USB PD charging feature on US and DS1 ports of CY6611 HX3PD.  

See CY6611 Hardware Design Overview to learn about USB data transfer and charging capabilities supported by HX3PD EVK’s 
US and DS ports.  

1. If the CY6611 EVK has been used to demonstrate USB 3.1 Gen 2 data transfer as described in the earlier sections, do the 
following steps to prepare the CY6611 EVK for the USB PD charging demo: 

 Detach the power supply from the CY6611 EVK board 

 Detach the SSD and other drives from the DS ports 

2. Connect the Type-C cable provided with the kit to CY6611 EVK boards’ US port; connect the other end of the Type-C cable 
to the Type-C port on a laptop supporting USB PD and USB 3.1 Gen 2 (10 Gbps) as shown in Figure 4-8. Ignore this step if 
CY6611 EVK is already connected to the laptop. 

3. Supply power to the CY6611 EVK using any of the following three sources: 

 Power Adapter provided with the kit 

 An alternate power adapter with higher output capacity 

 Using Bench power supply 

4. Power LEDs (LED3 - LED5) glow green to indicate that the kit is powered. Also, the PD CTRLR LED and DMC LED blink 
green to indicate that the firmware is running and the kit is ready for operation. 

5. The laptop starts charging once the USB PD contract is established. This can be verified on the display of the laptop (for 
example, Battery Charging status in System Tray area on a Windows laptop). Measure the PD contract voltage at test point 
TP35 (US_PD_VBUS) using a multimeter as shown in Figure 4-8. 

Figure 4-8. USB PD Charging Setup 

 
 

6. Connect a USB PD capable device (for example, mobile phone) on the DS1 port using the USB Type-C cable provided with 
the device. The device starts charging once the PD contract is established. Measure the PD contract voltage at test point 
TP17 (DS_PD_VBUS) as shown in Figure 4-9. 

Note: The CY6611 firmware is configured to support a maximum of 20 V, 2.3 A power on the US port and 5 V, 1 A power 
on the DS1 port. The CY6611 firmware can be configured to support a maximum power of 20 V, 3 A on both US and DS1 
ports simultaneously. See the Programming the HX3PD Controller chapter to configure the HX3PD firmware for this 
requirement. 

7. Simultaneous USB Gen 2 data transfer and USB PD charging can be demonstrated by connecting a USB Gen 2 SSD to any 
of the remaining USB Gen 2 DS ports (DS2-DS5) and initiating data transfer from the laptop (which is getting charged using 
the USB PD protocol) as shown in Figure 4-9. 

Note: DS1-DS3 ports use Type-C USB connector and DS4-DS5 ports use Type-A USB connector. Pick the DS port (DS2-
DS5) to connect the SSD, based on the connector type supported by the USB cable provided with the SSD. 
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Figure 4-9. Simultaneous USB PD Charging and USB 3.1 Gen 2 Data Transfer 

 
 
 
Note 1: USB Battery Charging Specification (BC 1.2) and Apple charging features are enabled on DS2 to DS5 ports by 
default. The devices which support USB BC 1.2 (for example, smartphone with BC 1.2 support) or Apple charging can be 
connected to these ports anytime to charge them. These charging protocols are supported simultaneously with USB 3.1 Gen 
2 data transfer and USB PD charging features. 
 
Note 2: HX3PD can also support Battery Charging (BC 1.2) and Apple charging features on DS6 and DS7 ports with custom 
firmware. Contact Cypress Technical Support for the custom firmware. 

 

4.5.1 Troubleshooting 

Table 4-3. Procedure to Troubleshoot issues with USB PD Charging and USB Gen 2 Data Transfer Demonstration 

# Issue Possible Cause Troubleshooting procedure 

1 Laptop connected to the 
CY6611 EVK’s US port is not 
charging 

The laptop may not support USB PD 
protocol 

Check the technical specification of the laptop and 
confirm that it supports USB PD 2.0 or 3.0 protocol 

2 The device (for example, 
mobile phone) connected on 
CY6611 EVK’s DS1 port is 
not charging 

The device may not support USB PD 
protocol 

Check the device’s technical specification and confirm 
that it supports USB PD 2.0 or 3.0 protocol 

The device’s implementation may require 
higher voltage PD contract to be 
established with CY6611 EVK to enable 
charging 

The CY6611 firmware is configured to support 5 V, 1 A 
PD contract on DS1 by default. The CY6611 firmware 
can be configured to support charging at higher 
voltage levels. See the Programming the HX3PD 
Controller chapter to configure the HX3PD firmware 
for this requirement and to download it on the CY6611 
kit. 

 

 

 

 

 

https://www.cypress.com/support
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5 Programming the HX3PD Controller 

 
 

 

5.1  EZ-USB HX3PD Configuration Utility Overview 

The EZ-USB HX3PD Configuration Utility is a Microsoft Windows based utility that enables configuration of the HX3PD firmware 
and programming the HX3PD controller with the firmware. See the utility’s Release Notes EZ-USB HX3PD Configuration Utility 
Release Notes.pdf available at <Install_Directory>\EZ-USB HX3PD Configuration Utility\Documentation\ to understand the 
PC/laptop’s system requirements to run this utility. 

Note: On Windows 32-bit platforms, the default <Install Directory> is C:\Program Files\Cypress and on Windows 64-bit platforms, 
it is C:\Program Files (x86)\Cypress 

5.2 Programming the HX3PD Firmware 

Follow these steps to download the HX3PD firmware on the CY6611 EVK: 

1. If the CY6611 EVK was used to demonstrate USB 3.1 Gen 2 data transfer or charging features (PD/BC) as described in the 
Kit Operation chapter, follow the steps to prepare the CY6611 EVK for programming the HX3PD firmware: 

 Detach the power supply from the CY6611 EVK board. 

 Detach the SSD and other drives/devices from the DS ports. 

2. Connect the power adapter provided with the kit to the DC Power Jack (J12) of the CY6611 EVK board. Plug the other end 
of the power adapter into an AC power socket. 

3. Identify the USB port on the PC/laptop to which the CY6611 EVK will be connected. It is recommended to connect the CY6611 
EVK to a Type-A port of the PC/laptop using a Type-C to Type-A cable. Otherwise, use the USB Full-Featured  
Type-C Cable, provided with the EVK, to connect CY6611 EVK to the Type-C port of the PC/laptop.  

  Figure 5-1. HX3PD Firmware Programming Setup 

 
 
Note: If the laptop on which the HX3PD Configuration Utility will run is powered by the CY6611 EVK, make sure that laptop’s 
battery is adequately charged for at least 10 minutes of continuous operation. Note that the HX3PD controller goes through 
reset cycles during the firmware download operation and the power provided by the EVK on US port to the laptop as per the 
USB PD protocol will momentarily get cut off till the newly downloaded firmware comes up. This transition can be observed 
on the System Power Status displayed by laptop’s operating system.  
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4. Launch the HX3PD Configuration Utility as shown in Figure 5-2. The HX3PD Configuration Utility is available at 
<Install_Directory>\EZ-USB HX3PD Configuration Utility\EZ-USB HX3PD Configuration Utility.exe. Click Help > About to get 
the version number details of the utility. 

Note: On Windows 32-bit platforms, the default <Install Directory> is C:\Program Files\Cypress, and on Windows 64-bit 
platforms, it is C:\Program Files (x86)\Cypress. 

Figure 5-2. HX3PD Configuration Utility with Version Details 

 

5. Go to the Update Firmware tab and specify the path to the HX3PD firmware file in the Composite image field as shown in 
Figure 5-3. Retain the default values for the other fields. The HX3PD firmware is available at <Install_Directory>\CY6611 EZ-
USB HX3PD EVK\1.0\Firmware\HX3PD_Composite_FW\CYUSB4347-BZXC_FW.bin. Click Update to initiate programming 
of the HX3PD firmware. 

Figure 5-3. Programming the HX3PD firmware 

 

Retain the default values for the other input fields available in the Update Firmware tab (DMC VID, DMC PID, and Re-
enumeration timeout). Re-enumeration timeout refers to the maximum time for which the Utility will wait for HX3PD to restart 
using the newly downloaded firmware and to start communication with the Utility. 

Log Pane with 
firmware 
programming 
status  
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The status of the firmware programming is displayed in the Log Pane. Also, the DMC LED will go through rapid and normal 
blink sequences alternately during the firmware programming activity.  

The firmware programming will complete in about three minutes. On successful programming, the message “HX3PD firmware 
update completed successfully” will be displayed in the Log Pane. 

6. EZ-USB HX3PD Configuration Utility also supports a feature to query the status of the HX3PD. The status details include the 
VID, PID, Vendor Name, Product Name, version number of the HX3PD firmware, and the result of last firmware upgrade 
operation. Click Get Status on the Update Firmware tab as shown in Figure 5-4. The status details are displayed in the Log 
Pane area.  

Figure 5-4. Get the firmware status of HX3PD 

 

 

Note: The Get Status feature can be invoked any time to understand the status of HX3PD. 

 

5.3 Updating the HX3PD Configuration and Generating a Composite Image 

The HX3PD firmware can be configured based on the CY6611 EVK usage requirements. For example, the default USB PD PDO 
of 5-V, 1-A supported on DS1 port can be modified to support 20-V, 2.25-A. See the EZ-USB HX3PD Configuration Utility User 
Guide to understand the procedure. You can access the user manual from the utility’s Help menu.  

 

 

Log Pane with 
HX3PD status 
details  
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Appendix A: Terminology 

 
 

 

A brief description on USB, USB Charging specification, USB Type-C, and USB PD terms are provided for reference. 

 USB Type-C (Type-C): The new USB connector specification for a slimmer and reversible connector, with extended power 
handling capability. The new connector supports latest USB and power delivery specifications. The connector is backward 
compatible with the previous USB specifications. 

 USB PD (USB Power Delivery): A new USB standard that increases power delivery over USB from 7.5 W to 100 W. 

 Upstream Facing Port (UFP): A USB Type-C port on a device or a hub that connects to a host or the Downstream Facing 
Port (DFP) of a hub and a default power sink. 

 Host: A USB host system such as a PC.  

 VBUS: A USB Type-C bus wire used for power; initially 5 V, but increased up to 20 V on USB PD systems. 

 DFP: A USB Type-C port on a host or a hub that connects to a device. 

 USB 3.1 Gen 2: Latest USB specification that supports a transfer speed of up to 10 Gbps. Also called USB 3.1. 

 BC1.2 (USB Battery Charging Specification v1.2): The latest version of USB based charging protocol.  

 SuperSpeed (SS), High-Speed (HS), Full-Speed (FS), Low-Speed (LS): The USB protocol support various transfer speeds. 
Low-Speed (1.5 Mbps) and Full-Speed (12 Mbps) were introduced with first version of USB specification (USB 1.1). High-
Speed (USB 2.0) supports a transfer speed of up to 480 Mbps. Super Speed introduced by the USB 3.x specification, supports 
5 Gbps (USB 3.1 Gen 1) and 10 Gbps (USB 3.1 Gen 2). 

 Fast Role Swap (FRS): Ability of a Dual Role Port (DRP) to switch power roles between sink and source. The FRS was 
introduced with latest power delivery specification (USB PD v3.0). 

  Figure A-1: USB Type-C Plug and Receptacle 
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Document Revision History 

Document Title: CY6611 EZ-USB HX3PD Evaluation Kit Guide 

Document Number: 002-26068 

Revision ECN# Issue Date Description of Change 

** 6890431 06/01/2020 Initial version of kit guide 

*A 6906163 06/26/2020 

Updated Abbreviations. 

Detailed Installation to specify the following: 

    Installing the EZ-PD Configuration Utility 

    Installing the EZ-USB HX3PD Configuration Utility 

    CY6611 EZ-USB HX3PD EVK Software Installation 

    Cypress Update Manager Check 

Updated CY6611 System Design. 

Added Troubleshooting points in Table 4-1 and Table 4-2. 

Added note in Demonstrating USB PD Charging on US and DS1 Ports. 

 

 

 

Revision History 

 
 


	CY6611 EZ-USB HX3PD Evaluation Kit Guide
	Contents
	Safety Information
	General Safety Instructions
	ESD Protection
	Handling Boards


	1 Introduction
	1.1  Kit Contents
	1.2  List of Recommended Hardware
	1.3 Getting Started
	1.4  Additional Learning Resources
	1.4.1 Technical Support

	1.5  Document Conventions
	1.6 Abbreviations

	2 Installation
	2.1 Installing the EZ-PD Configuration Utility
	2.2 Installing the EZ-USB HX3PD Configuration Utility
	2.3 CY6611 EZ-USB HX3PD EVK Software Installation
	2.4 Cypress Update Manager Check

	3 CY6611 System Design
	3.1 CY6611 EVK Overview
	3.2 CY6611 Hardware Design
	3.2.1 CY6611 Hardware Design Overview
	3.2.2 CY6611 Jumpers, LEDs and Headers
	3.2.3 Measuring Power Consumed by HX3PD Controller


	4 Kit Operation
	4.1 Pre-requisites
	4.2  Powering CY6611 EVK
	4.2.1 Troubleshooting

	4.3  Connecting EVK to Laptop
	4.4 Demonstrating USB 3.1 Gen 2 (10 Gbps) Data Transfer
	4.4.1 Troubleshooting

	4.5 Demonstrating USB PD Charging on US and DS1 Ports
	4.5.1 Troubleshooting


	5 Programming the HX3PD Controller
	5.1  EZ-USB HX3PD Configuration Utility Overview
	5.2 Programming the HX3PD Firmware
	5.3 Updating the HX3PD Configuration and Generating a Composite Image

	Appendix A: Terminology
	Revision History
	Document Revision History



